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Section 1: Introduction  

1.1 A Letter from the Chairman and Founder  

Thank you for purchasing Depiction ñmore than mappingò software. 

Our goal is to provide you with the visualization and simulation tools that were earlier available 

only to those with expertise and money. Depiction is a new experience that combines 

simulation, mapping and collaboration. We work hard to make it easy for you to jump right in to 

create and explore scenarios important to you. From the design of the menus to this manual you 

are reading, we want to make the Depiction experience easy for you.  

Depiction can be used to geospatially present a variety of data.  This can be free data from the 

Internet or your own data from spreadsheets or maps and images. Depiction can be used to 

provide improved situational awareness and understanding of ñwhat-ifò possibilities, to present a 

common operating picture, to plan hypothetical scenarios, to display locations of people and 

other assets, to present demographic data, and many other uses that are waiting to be 

discovered. 

We know that Depiction is just a toolða means to your ends. And just like a good hammer that 

unconsciously becomes an extension of a carpenterôs arm, it is our hope that Depiction is a tool 

that ñdisappearsò in the hands of its users as they craft and share stories important to their 

community. 

We welcome your feedback on this manual and on topics you think we need to expand upon or 

explain better. Please do not hesitate to write to us with your feedback and suggestions at 

info@depiction.com. We look forward to hearing your voice and acting on what we hear. Your 

opinion shapes our website, product features, and just about everything we do. 

We have added a new section to the end of the manual in Appendix B that we are calling GIS 

101. If you have never worked with Geographic Information Systems (GIS) before, I would 

encourage you to read it first as it may help you better understand mapping and GIS 

terminology and concepts. 

Thank you for being a part of the Depiction story!  

 

Mike Geertsen  

Chairman of the Board and Founder 

 

 

mailto:info@depiction.com
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1.2 Overview  of Some Important Concepts in Depiction  

Before you get started using Depiction it may help to have a better understanding of some of the 

concepts and terminology in the software. First off, in this manual (and elsewhere), a file created 

in Depiction is referred to as a ñdepictionò. 

Elements: Everything in a depiction is referred to as an ñelement.ò Elements generally 

represent things in the real world such as a person, a shelter, a satellite image, a road network, 

or elevation data. Elements are placed (depicted) on your background (display). Elements can 

be a point, line, polygon, or may consist of a system of lines or shapes that span the entire 

depiction; for example, an OpenStreetMap road network. Each element has an associated set 

of properties that define or describe what the element ñisò as well as its current ñstate.ò At a 

minimum, each element has a geographical extent (its zone of influence) and a name. Depiction 

has a number of pre-defined elements, each with an associated list of properties, and many 

properties have a default value.  

 

Behaviors: Depiction elements are designed with or assigned ñbehaviorsò.  The behavior 

assigned to an element determines how the element acts or what the element ñdoesò in a given 

scenario. The behavior may be inherent in the definition of the element or it could be a change 

in one or more properties of the element as a result of an interaction between the element and 

one or more other elements. A Flood element, for instance, has been designed to compute the 

flood extent using elevation data.  Depiction contains a set of behaviors that elements can use, 

and you can assign these behaviors to your elements. You do this by copying an existing 

interaction that would assign a behavior to a new element. 

 

Interactions: Interactions determine how elements and behaviors in depiction affect each other. 

In Depiction, you use the Interactions option under Tools in the main menu bar to view, edit and 

create interactions. Interactions generally are invoked when the geographical extents (zones of 

influence) of elements overlap. The Route - road network is a good example of an element that 

has behavior and interacts with other elements. Flood is another element with behavior that may 

impact other elements (for example, buildings and persons) that are within the zone of influence 

of the flood. When the zones of influence of elements overlap, the properties and/or behaviors 

of the affected elements may change. For example, when a flood covers an area containing a 

set of buildings, the buildings become ñinactiveò (shown by a red ñXò over the element icon). 

Reducing the zone of influence of a flood so that it no longer overlaps the building restores the 

building to ñactiveò status (the red ñXò goes away). Each interaction consists of a cause element, 

a set of affected elements, and an action to perform on the affected elements. In the flood 

example: 

¶ The flood is the cause element.  

¶ Affected elements include buildings and shelters.  
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¶ The action is to set the Active property of the affected elements to false if the flood 

overlaps the affected element. Buildings and shelters that do not overlap the flood are 

not affected.  

 

Interactions are bundled with elements so that when you add an element to your depiction, it 

comes with a set of pre-defined ways that it interacts with other elements. Depiction also allows 

the user to create new interactions, or modify or delete existing interactions. See Section 7.2 for 

more on Interactions and how to use them effectively in Depiction. 

1.3 Whatõs New in version 1.3  

¶ Element Information is now Element Properties with many changes and enhancements  

¶ Most menus are now independent windows, allowing the user to drag them to a second 

monitor  

¶ Cancel button on Region selector tools returns the user to the Location screen  

¶ Region boundary has a new look to be more visible against any background   

¶ Scale is now shown below the Position  

¶ Re-sizeable menus: user can size most menus vertically and horizontally with the 

mouse  

¶ Drawing tools: Line, Circle, Polygon, Rectangle elements  

¶ Route (road network & user drawn) element: click to designate start, waypoints and end 

points  

¶ User can now designate the shape of an icon border  (circle, triangle or square) in the 

Element Properties box  

¶ Add Content menu grays out elements that cannot be added by a particular method 

(mouse, file, live reports, web service)  

¶ Changes to the Settings dialog (via the Welcome screen or Tools menu):  

o Separated measurement system and scale  

o Added ñOverwrite existing cache with newò check box  

o Added method to view the default home directory for the user 

¶ UTM coordinate format is now available (via the Settings dialog on the Welcome screen 

or Tools menu)  

¶ Interactions Menu has a new look and name: Interactions Repository Viewer  

¶ Geo-align image: if the user needs to correct the alignment of an image, simply double-

click the image to go back to the geo-align image mode  

¶ Enhanced hovertext: allows for the inclusion of HTML in hovertext, including image 

links (<img>) and URLs  

¶ Element property names can now be hidden in hovertext when multiple properties are 

shown  

¶ Live Reports refresh rate setting in the add content menu and on the live feed  

¶ Select tool: allows the user to select multiple elements on the background to manipulate 

in the Manage Content menu  
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¶ Hide and Show buttons on the Manage Content menu allow the user to show or hide 

selected elements on the depiction background  

¶ Element Creation: a new Element Definition Editor for creating custom elements (on the 

Tools menu)  

¶ Copy current location: right-click and select this option to copy the position of the 

mouse pointer into the clipboard  

¶ Performance enhancements in loading and saving depiction files and shapefiles  

¶ 1.3.1 ï EID update choice is now in CSV import wizard 

¶ 1.3.1 ï CSV import Geo-coding is now limited to 1,000 records. 

¶ 1.3.2 ï Export elements to a CSV file now asks if the Zone of Influence should be 
exported.  

¶ 1.3.2 ï Routes path calculation speed has been improved.  
¶ 1.3.2 ï Selecting the 'Content' button from a revealer now displays the Display Content 

dialog with the appropriate revealer selected.  
¶ 1.3.2 ï Elements that are loaded from a 1.2.2d depiction now display more properties. 
¶ 1.3.2 ï Proxy settings now work properly. 
¶ 1.3.3 ï Elements from the QuickAdd Toolbar are added in single versus multiple mode. 
¶ 1.3.3 ï New background sources from MapQuest Open (map and imagery). 
¶ 1.3.3 ï New Road Network method allows for smaller downloads and better 

performance in large areas. 
¶ 1.3.3 ï The settings menu now has Basic and Advanced tabs: see section 7.2. 
¶ 1.3.3 ï When right-clicking on a single element, options for the element are shown 

without a sub-menu: see section 9.5. 
¶ 1.3.3 ï New tooltips and context-sensitive text. 

Section 2: Welcome Screen 

2.1 Resources 

Before you work with Depiction, please take note of the resources available to you, such as: 

video tutorials, online help, samples and downloads, webinars, online forums, blogs, frequently 

asked questions, and more available on our Help page. All of these resources, plus updates to 

version one of Depiction are available with a purchase of Depiction. 

2.2 Software and Hardware Requirements 

Depiction is designed to run on very basic computers. Any laptop or desktop built over the last 

five years running Windows XP, Vista or Windows 7 can run Depiction.  Depiction will only work 

on a Macintosh if you are running Windows via Boot Camp or a virtual machine program. The 

minimum system requirements are: 

¶ Microsoft Windows 7, Windows Vista, or Windows XP with Service Pack 2 (SP2) 

¶ 400 MHz Pentium Processor (1 GHz recommended) 

¶ 512 MB RAM, or 1 GB when running on Vista (2 GB recommended) 

¶ 90 MB hard drive space (plus possible additional space for .NET frameworks if not 

previously installed) 

http://open.mapquest.com/
http://www.depiction.com/help
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¶ Minimum display setting of 800x600, 16-bit high color (1024x768 and 32-bit true color 

recommended) 

However, as with any program, more memory and a faster processor will provide better 

performance. 

2.3 Exploring the Depiction Environment 

 

To start the Depiction application: 

¶ Click the Depiction icon on your Desktop or, 

¶ Click the start menu icon at the lower left corner of the Desktop. Point to 

All Programs, find the Depiction Inc folder and click on the Depiction icon.  

2.4 Welcome Screen 

 

Welcome Screen: choose from the six options on the screen: 

¶ New Depiction: Allows you to start a new depiction file. 

¶ Open Depiction: Allows you to open a previously saved depiction 

file. 

¶ Help:  Opens the Help menu with options including help file, tutorials, 

your license (serial number),  and information about Depiction. 

¶ Settings: Where you can choose the latitude/longitude format, 

measurement unit, and proxy server settings. 

¶ Tutorials: Online videos demonstrate different Depiction tools. 

¶ Samples: Provides you with a list of five sample depictions. 

¶ Exit: Exits the Depiction program. 

 

2.4.1 New Depiction  

Welcome Ą New Depiction 

 After you choose New Depiction from the Welcome 

Screen, you can enter a geographic location in one of 

various formats:  

¶ City and state, territory, province, etc. Ex: Seattle, 

WA 

¶ City and country Ex: Paris, France 

¶ A zip code Ex: 98004 

¶ A street address Ex: 1600 Pennsylvania Ave, 

Washington, DC 

¶ Latitude and Longitude Ex: 47.55N, 128.36E                             

¶ Famous Place Ex: Eiffel Tower, Disneyland, Space 

Needle 

Once you enter the location information, click go to 
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location. Note: for this to work properly you need an 

Internet connection. 

 

 

 

A map appears giving a street-map view of the location 

you entered. A yellow rectangular box appears on this 

map. The boundaries define the region in which Depiction 

will bring in imagery and data and where your elements 

will interact. You can change the dimensions of the 

boundaries to select your depiction area in the following 

ways: 

¶ Click and drag inside the box to move the boundaries 

¶ Click and drag outside the box to move the 

background map  

¶ Click and drag the edges or corners of the box to 

change the size of the boundaries 

¶ Use the Page up and Page down keys or the 

mouse-scroll wheel to zoom in and out. 

 

Once you position the boundaries to encompass your area 

of interest, click Done on the upper-right corner. 

 

If you decide that this is the wrong area and you wish to 

pick a new location then click Cancel and you will be 

returned to the Location screen. 

 

If you select a region larger than 15,000 square miles, you 

will see this warning. Depictions can be created at any 

size, but loading detailed datasets such as elevation and 

road networks can cause serious performance issues.  
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Quickstart Data Sources  

 

After you click Done, a refined map of your area of interest 

appears. Depiction uses the Internet to find public data 

available in your region and lists the available Quickstart 

data sources in a dialog box. Select your choices using the 

check box  on the left. Click  for more information about 

each option. Click  to open the Help window. 

 

Select the data and then click OK. Depiction downloads the 

selected data. The Processing control shows the details of 

the data requests that are in the downloading process. It will 

disappear once the data loads. Quickstart imagery and 

elevation are loaded into Revealers. 

 

Tip: You should only load data you intend to use, because 

too much data can impact performance.  You can always add 

additional Quickstart data later from the Add menu option. 

Getting Started  

 

After you select your options from the Quickstart 

data sources dialogue, Click OK and a Getting 

Started Tip Box appears. 

 

You can opt to check the Do not show again 

option, and click Close once you finish reading. 

 

Revealer Window 

 

Depiction allows you to selectively display data 

using innovative Revealer technology. Revealers 

are rectangular or circular areas of any size that, 

when moved around the display, reveal the 

elements that have been assigned to that 

revealer. Revealers are explained in more detail in 

the Display Menu section of this manual.  

 

Imagery and elevation data selected in the 

Quickstart Data dialogue will automatically appear 

in Revealers. 
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Ex: A street map image is ñrevealedò over an 

aerial view. 

2.4.2 Opening a Depiction  

Welcome Ą Open Depiction 

 To open an existing depiction, choose Open 

Depiction from the Welcome screen. Find the folder 

that contains your file ï ensure it has a .dpn extension 

ï select and click Open, or just double-click on the 

file. 

 

Tip:  Double-clicking on a saved .dpn file in Windows 

Explorer will automatically launch the Depiction 

application and load the selected file. 

 

2.4.3 Help Options 

Welcome Ą Help 

 

The Help menu contains with the following options: 

¶ Help: Opens Depictionôs Help file, which gives a detailed 

explanation of all Depiction menus and features. 

¶ Tutorials:  Opens a web page displaying online instructional 

videos demonstrating selected features of Depiction. 

¶ Licensing: Shows your valid 16-character Serial Number. 

¶ About: Shows the latest version of Depiction on your system.  It 

also displays third party licensing information. 

¶ EULA: The End User License Agreement shows your contract 

with Depiction. 
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2.4.4 Settings  

WelcomeĄ Settings 

 

The Settings menu contains with the following 

options: 

¶ Zoom about center of window: If selected 

when you zoom in and out it, it will do so 

from the center, as opposed to the current 

pointer location. 

¶ Number of digits after the decimal: 

Allows you to choose the number of 

decimals places to display from 1 to 5. This 

does not apply to the Lat/Long precision 

which is always 5 digits. 

¶ Measurement System: Allows you to 

choose from imperial and metric display. 

¶ Scale: Allows you to choose one of the 

following three options: 

o Small = inches/centimeters 

o Normal  = feet/meters 

o Large =miles/kilometers 

¶ Coordinate format:  Allows you to choose 

from several formats to display latitude and 

longitude or UTM (Universal Transverse 

Mercator format). 

¶ Proxy User Name and Password: Allows 

you to enter a proxy user name and 

password 

¶ Overwrite existing cache with new: When 

you have tiling background images, they 

are cached on your disk to improve 

performance and enable offline access. 

However, it is possible that newer 

information is available from the source, 

particularly OpenStreetMap.  By checking 

this box Depiction will go to the Internet to 

get the newest imagery.  

¶ User home directory: The location where 

the cache information is stored. 

See Section 7 ï Tools menu for more details 

about these options.  
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2.4.5 Tutorials & Samples  

WelcomeĄTutorials 

 

 

Clicking the Tutorials button will open your default 

browser to the tutorials page on depiction.com where you 

will find video resources to take you through some key 

features: 

Getting Started: Illustrates the basics required to 

get started (Duration 7-minutes) 

Geo-aligning Images: The powerful ability 

Depiction provides to geographically align any 

image to your depiction (Duration 5-minutes) 

Interactions: Edit and create your own interactions 

(Duration 5-minutes) 

Additional tutorials are being added regularly. 

WelcomeĄSamples 

 

Samples includes five sample depictions of 

various scenarios included with your installation 

that the user can open and explore: 

¶ Philadelphia Plume Scenario: Depicts 

a scenario outlined in Stephen Flynnôs 

The Edge of Disaster in which terrorists 

have attacked Philadelphia. 

¶ Nursing home evacuation: Depicts 

how an earthquake might precipitate a 

nursing home evacuation in Seattle, 

WA. Try different routes and blocking 

routes with Road Barriers. 

¶ Tsunami in India: Depicts a 15-foot 

tsunami inundation for Nagapatnam, 

India. Try different tsunami heights. 

¶ Using revealers: Try different ways to 

use revealers in a depiction. 

¶ Route finding in Afghanistan: Explore 

different road and air routes, to avoid 

possible problems between Kandahar, 

Afghanistan and its airport. 

 

More sample files are available online at 

www.depiction.com/downloads  

 

http://www.depiction.com/downloads
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Section 3: File Menu  

 

The File menu option allows you to create a new depiction, open an existing depiction, or save 

an existing depiction project.  In addition, you can enter descriptive information about your 

current depiction, print the current screen or exit the program.  When saving a depiction, all the 

elements, interaction rules, and display settings associated with that depiction are saved. 

3.1 File Menu  

 

Main Menu Bar ĄFile Menu  

 

The File dropdown menu has the following options: 

¶ New: Create a new depiction. 

¶ Open: Open a previously saved depiction. 

¶ Save: Save a depiction that you have created or save the 

changes that you have made to an existing depiction. (Note: all 

of the data in your depiction will be saved to your hard disk 

including data downloaded from the internet). 

¶ Save as: Save a depiction with a different file name. 

¶ File information: View and edit information about the current 

depiction file such as title, author, and description. 

¶ Print: Print the current Depiction display. 

¶ To welcome screen: Go back to the Welcome screen. 

¶ Exit: Exit from and close the Depiction application. 

3.2 Creating a New Depiction  

FileĄNew (See section 2.4.1)  

3.3 Opening an Existing Depiction  

FileĄOpen 

 

Select the Open option from the File menu. If a 

depiction is open, the Save depiction message 

appears. Select one of the following options: 

¶ Yes: To save the depiction that is currently open. 

See section 3.4 below. 

¶ No: To open a new depiction without saving the 

current depiction.  

¶ Cancel: To cancel the action and continue working . 
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The Open dialog box appears. 

¶ Select the location on your computer either by 

selecting one of the options on the left side of the 

dialog box or by selecting a location from the Look 

in: dropdown list. 

¶ Select the folder from the folders list. 

¶ Select the file you want to open. The file name 

appears in the File name: textbox. 

¶ Click the Open button. The progress bar appears. 

After the opening process is completed, the selected 

depiction displays on the screen. 

3.4 Saving a Depiction  

FileĄSave or FileĄSave As 

 

Select the Save or Save As option from the File menu.  

The Save As dialog box appears. Enter the following details: 

¶ Select the save location in the Save in dropdown list. 

¶ Select the folder or create a new folder where you want to 

save the depiction. 

¶ File name: Select a file from the dropdown list or enter a 

name for the file in the File name: textbox. 

¶ Save as type: Select the file type. The default file type is 

Depiction Files (dpn). You must select the default option 

for all files to be saved as depictions. 

¶ After entering the details, click the Save button to save the 

file.  

3.5 Viewing, Entering, or Changing File Information  

FileĄFile Information  

 

Select the File information option from the File menu.  

The File Information dialog box appears and displays the file 

details. To enter or change the details: 

¶ Title: Enter or change a descriptive name for the 

depiction.  The title can be different from the file name. 

¶ Author: Enter or change the name of the depiction 

author. 

¶ Description: Enter or change the description of the 

depiction.  

¶ After entering the details, click one of the following: 

¶ Cancel: Click cancel to discard the entries/changes. 

¶ Apply:  Click apply to apply your changes. 
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¶ OK: Click the OK button to save the entries/changes.   

3.6 Printing a Depiction  

FileĄPrint  

 

 

 

 

 

 

¶ Select the Print option from the File menu. The 

Printing options message box appears.  

¶ Select the Include menus and controls checkbox 

if you want to print all the elements, controls, and 

menus in the depiction.  

¶ To print the depiction with all the elements but 

without the controls and menus, leave the Include 

menus and controls option unchecked. 

¶ Click the Print button. The Print dialog appears. 

Note: This option prints what currently appears on 

the screen. It will not print the entire depiction 

unless the entire depiction appears on the screen. 

Enter the following details: 

¶ Select Printer: Select the printer from the list. 

¶ Number of copies: Use the arrow to select the 

number of copies that you want to print. 

¶ Click Print to start printing. Ensure your printer is 

connected and turned on, and that there is enough 

paper to complete the print job. 
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3.7 Closing Depiction and Exiting   

FileĄExit 

 

Select the Exit option from the File menu to close 

Depiction. If you have not saved the current depiction, 

the Save depiction message appears. 

Select one of the following options: 

¶ Yes: To save the depiction that is currently open. 

¶ No: To open a new workspace without saving the 

current depiction project.  

¶ Cancel: To cancel the action and continue 

working in the current depiction project. 
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Section 4:  Add Menu  

4.1 Add Menu  

Everything in a depiction (with the exception of background tiling) is referred to as an element.  

Depiction elements represent things in the real world such as people, shelters, satellite images, 

road network, elevation data, and more.  Add Content lets you add elements to your depiction. 

Main Menu Bar ĄAdd  

 

Add Content opens from the main Menu and includes six options: 

¶ Mouse: Add one or more elements to your depiction with 

each left mouse click. 

¶ Location: Add elements by specifying a location either by 

coordinates or address. 

¶ File: Import elements from a file, including CSV (Comma 

Separated Value spreadsheet), elevation (.dem, .adf, etc. ), 

ESRI Shapefiles (.shp), GML (Geographic Markup 

Language), images (.jpg, .tif, .png or .bmp), GPS (.gpx) and 

more. 

¶ Live Reports: Add elements from one or more  e-mail 

accounts. 

¶ Web Service: Add data from Web Feature or Web Mapping 

Services (WFS or WMS) 

¶ Quickstart: Add publicly available data that Depiction has 

identified for your depiction area 

4.2 Adding Elements  

Add Ą Mouse 

 

The simplest way to add elements is with the 

Mouse. 

1. Choose to add a single or multiple 

elements from the left pane. 

2. Choose the type of element to be added 

on the right pane and click, Add. 

Tip: Elements here are divided into 

Default, User Definitions, Loaded 

Definitions (if available) and definitions 

from Add-ons. Scroll down to see all 

elements.   

3. Left-click to add elements. 

4. If Multiple is selected, click Done or 
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press Esc to finish adding. 

Add Ą Address 

 

Add elements by specifying a geographic 

location.  

1. Click Location on the left pane. 

2. Type in the geographic location 

information:  

¶ Latitude and Longitude Ex: 

47.55N, 128.36E 

¶ Street address, City, 

State/Province, Zip/Postal Code, 

etc. 

3. If desired, select ñCenter screen on 

element.ò This is useful if you are 

unfamiliar with the location entered. 

4. Select the element you want to place 

at that location entered. 

5. Click Add.  

Tip: You must have an Internet connection to 

place any location information that is other 

than a geographic coordinate 

(latitude/longitude).  

 

Add Ą File 

 

Add elements to your depiction by loading 

files of any of the following formats: 

¶ CSV: Comma separated values are 

specifically formatted spreadsheet files. 

¶ Elevation: A grid file of elevation 

values; usually with extension .adf, .tiff 

or .dem, 

¶ ESRI Shapefile: A group of related 

files (.shp, shx, .dbf) with geospatial 

vector information. 

¶ GML: Geographic Markup Language 

files 

¶ Image: Any image file, such as .png, 

.jpg, .bmp and others. 

¶ GPX: The GPS eXchange format 

generated by GPS devices 
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Tip: See section 10.4 for a detailed 

description of these various file types. 

 

Example #1: AddĄFileĄCSV 

 

You can add elements from comma-separated value files 

(CSV); these have the file extension ".csv".  

Tip: You can easily create a CSV file from Microsoft Excel 

by choosing Save As and selecting CSV (Comma 

delimited). 

The first line of a CSV contains column headers 

(properties).  Each additional line or row represents an 

element and contains the property values for that 

element.  The values in a column labeled Element type 

are treated specially and specify the type of element to 

create, such as Person or Explosion. If Depiction does 

not recognize a specific Element type, it will assign the 

default element type chosen by the user at time of import 

(or a Point of Interest if a default type was not chosen). 

To import a CSV, open Add Content, select File and 

press Browse to find the file.  Ensure the file name 

appears in the Browse pane. Select the element, then click 

add. Alternatively, you can just drag and drop the .csv file 

onto your depiction. 

 

 

The CSV Import Wizard appears when adding a CSV file 

to your depiction whether from the Add Content menu or 

by dragging and dropping.  The wizard displays the first six 

rows in the file, -- the column headers and five rows of 

data -- and allows the user to select the columns Depiction 

will use to locate those elements geographically 

(ñgeolocateò).   

Tip: You can also update existing elements by importing 

from a CSV file using a field called EID. The next section 

discusses this, and for more information see Section 

10.2.1: Element Identifier. 

Depictionôs default conventions are that ñPositionò contains geographic coordinates and 

ñLocationò contains street address information (Street, City, State and Zip Code) for converting 
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to geographic coordinates (called geo-coding).  The Wizard allows the user to select the specific 

columns to be used regardless of how they are named.   

You should always confirm, by checking the data records at the bottom of the Wizard, that the 

information under the columns being used to locate the elements contains the appropriate 

information.  

Checking the Only import elements within my depiction area box will "crop" the CSV file 

contents so that the only elements imported will be those within the depiction region.   

Tip: If addresses include an apartment # or PO Box, make sure they are in a separate field from 

the address, as otherwise it may not be converted properly. Depiction will place elements with 

addresses it cannot locate in the center of the Zip code supplied. If Depiction cannot geocode 

an entry at all, it will be placed in the ñto be geo-alignedò tab in the Manage Menu. Depiction has 

a limit of 1000 geocodes per CSV file. 

 

Use the upper portion of the Wizard to choose the columns 

Depiction will use to locate the elements. The grey drop-

down boxes will preselect column names that match the 

location-related property names Depiction uses. Location 

columns not automatically selected can be selected 

manually (e.g. ñAddressò for Street, or ñXò for Longitude). 

 

The user can also select the Element type to create from 

the data in the file.  Note that this selection will be ignored 

for element type specified with an ñElement typeò column 

header. 

Tip: Depiction imports all the data in the file as characters; and does not preserve spreadsheet 

formatting information (such as: Formulas, row column color, pages, etc.). 

 

If a depiction contains elements with a unique Element 

Identification property (EID), those elements can be 

updated using a CSV file that also contains a matching 

EID property.  If a CSV file has an EID field, an additional 

Update by EID only radio button will appear above the 

Latitude/Longitude radio button.  See more details in 

section 10.2.1.  

 The Properties window appears after all elements from 

the file have been imported, and displays all of the 

properties that are common to all the elements just 

imported. Any modifications made in the Properties 

window will apply to ALL imported elements. 

 

When Depiction imports a file of data (spreadsheet, 
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shapefile, etc), it will automatically create new Properties 

with names corresponding to any column headers/labels 

not already existing for the element type imported. See 

Section 5.2.1 for a detailed discussion of the Properties 

window.  

Example #2: AddĄFileĄImage  

 

Depiction allows any map, drawing or picture to be 

added as an image element.  To add an image file to 

your depiction, select Add, click File then browse to your 

image file location and click Add.  

 

Tip: If you add a map or aerial image then you can geo-

align it. If you add a photograph or document you can 

place it anywhere convenient on your canvas. 

 

When Depiction is finished loading the file, you will get 

an Alert prompt to Geo-align content using Manage 

Content.  

 

In the Manage menu, click the element to geo-align 

tab. Select list by types. Select  Image, and click Geo-

align. 
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Your image appears on the display 

with active handles on the sides. The 

handles allow you to rotate and adjust 

the size and shape of the image so 

you can geo-align it with the 

background.  

 

You can zoom and pan the image or 

background and adjust the 

Transparency of the image using the 

sliding bar. 

 

Un-checking ñPreserve aspect ratioò 

allows you to stretch the image in any 

direction. Once you have the image 

aligned/located where you want it, click 

Finish.   

To re-align the image, just double-click 

on the image.  

AddĄLive Reports 

  

To add elements via the Live ReportsÊ function, which 

uses e-mail to download information, open Add 

Content and click the Live reports button. 

 

Choose your E-mail Provider from the drop-down 

Menu. This list also shows any e-mail accounts you may 

have previously used. 

 

If the e-mail address is one of those youôve previously 

used, you will only need to enter the password. 

 

Depiction is configured to work with Hotmail Plus, 

Yahoo! Plus and Gmail accounts. If you have one of 

those accounts, select the provider and enter the 

account name and password. 
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Otherwise, select the Other POP3 account options, and 

enter the full address for the email account, such as 

me@mail.com, the e-mail account's password and the 

POP3 Server. If your email provider requires it, check 

Use SSL.  

 

You may also set the refresh rate of the live report, to 

specify how often you want Depiction to check for new 

emails. 

 

Next, select the default element definition to use for the 

elements created from the emails. If the email subject or 

body specifies an element definition, that definition 

will be used instead of your chosen default, but if no 

element type is specified, then this selection will be 

used. 

 

See Section 10.1 for detailed email account and Live 

reports information. 

 

When you click Add, the Processing dialog will appear 

in the upper right, showing the status of emails Depiction 

is reading. 

 

After the mailbox has been checked, the message will 

change to a ñwaitingò message until the next check. 

Press  to check the mailbox immediately, and  to 

stop adding Live Reports from that account. 

 

AddĄWeb Services 

 

Depiction makes it easy to add content from web mapping and 

feature services if you know the URL for the web service: 

¶ Select WFS or WMS. 

¶ Enter the URL.   

¶ Click Show content. 

¶ A list of available layers on the Web service will appear 

under Content (layers) 

¶ After selecting the content, choose the Image styles and 

the format (optional) 

¶ Make sure Auto Detect is selected in the ñas this element 

typeò column. 

¶ Click Add and the imagery or data will appear in your 

depiction. 
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AddĄQuickstart  

 

The list of Quickstart data sources available 

for your current depiction area is always 

accessible via Add, Quickstart.  Just check 

the data sources desired  and click Add.  

Note that an Internet connection is required to 

retrieve the available Quickstart list and to 

add Quickstart data. 

The information button  gives information 

about each data source option. 
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4.3 Default Elements  

By default Depiction includes 58 elements. Each element has a unique name and properties. 

Twelve of these elements have some form of simulation behavior and are described in more 

detail in section 10.2. The following elements appear in the Add content menu:  
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Section 5:  Mana ge Content  

 

All the elements in your Depiction are listed under the Manage Content ñelementsò tab.  

Manage Content functions somewhat like a database manager, allowing you to manipulate the 

elements in your depiction in a variety of ways.   

5.1 Manage  

 

Menu ĄManage  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Manage in the main menu bar in 

Depiction to open the Manage Content 

menu.  

 

Tip: Any action taken  in Manage Content 

mode will affect all selected elements. For 

example, if you click delete , all selected 

elements  will be deleted . If only one 

element is selected, then only one will be 

deleted .  

 

Manage Content has two tabs: 

¶ Elements: Lists the elements in your 

depiction. The tab heading also indicates 

the total number of elements.  

¶ You can list elements by types (such 

as elevation, road network, water 

bodies etc.), by tags, or list every 

individual element in your depiction by 

choosing Show all data.  

¶ You can find a subset of elements by 

using the Filter elements by hover 

text box. Enter text here, and only 

elements having matching text in their 

hover text  will be listed. For example: 

If you wanted to find a person with the 

name Ardis, type óArdisô in the filter 

box. All elements that have ñArdisò in 

their hover text will be listed.  

¶ Elements to geo-align: This tab lists all 

the data, maps, images or drawings that 

may have been added to your depiction 
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but that need to be geo-aligned or geo-

located. The tab heading indicates the 

number of elements to be geo-aligned. 

¶ You can list the elements by types, by 

tags or individually using the Show all 

choice in the drop down menu. 

Manage Content has the following options on 

the elements tab: 

¶ Geo-align: Relocate the selected 

element. This button is only functional 

when only one element is selected.  

¶ View/Edit: Opens the Properties box 

for the selected elements. 

¶ Export to File: Export the selected 

element(s) to a Geography Markup 

Language (GML) file or to a to a 

comma separated value (CSV) file. 

¶ Send: Send selected elements as 

email. 

¶ Delete: Delete the selected elements. 

¶ Bring to center: Center the display on 

the element selected. This button is 

only functional when one element is 

selected. 

¶ Hide: Clicking this button will hide any 

of the selected elements on the 

display,  the same function as un-

checking an element or group in 

Display Content. 

¶ Show: Shows any selected elements 

that were hidden. 

¶ Close: Exit Manage Content dialog 

box.  

 

The following options are available on the 

elements to geo-align tab: 

¶ Geo-align: use to align images to your 

depiction background, geo-locate a 

point element by address or mouse. 

¶ View/Edit: use to see and change 

properties imported. 

¶ Delete: Remove the selected 
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element(s) from the depiction. 

 

5.2 View and Edit Elements  

ManageĄElementsĄView/Edit  

 

¶ Select elements by checking the checkbox 

on the left side of the listed element or 

elements. The menu list on the right side of 

the dialog box is activated as soon as you 

select one or more elements. 

¶ Click on View/Edit and the Properties box 

appears for the selected elements. See 

below for additional information. 

5.2.1 View, Set, or Change Properties  

 

The Properties window has the following 

options: 

¶ Set properties: View, change or add to 

the selected elementsô properties and 

property values. 

¶ Set tags: View, change or add to the 

tags for selected elements. 

¶ Set hover text: View or change the 

hover text options for the elements. 

¶ Colorize: Allows the user to 

thematically map a group of elements 

by color.  
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ManageĄElementsĄView/Edit ĄSet Properties   

 

Set properties:  The Element Information or 

Element Group Information box automatically 

opens with Set properties selected. The list of 

properties and values for the selected elements 

appears to the right. 

 

When multiple elements are selected, the 

Properties box shows all properties common to 

each element selected.  The values shown for the 

properties are for the first element in the group, 

not necessarily all the elements in the group. 

 
 

 

Tip:  If you select elements of different types, it is 

possible that the number of properties showing in 

the ñElement Properties in commonò window will 

be small, because different elements may have 

few properties in common.  

 

Element properties can be added, edited, and 

sometimes deleted:  

¶ To delete a property, click on the symbol 

next to the property name in the Actions 

column.  A red strikethrough line will appear, 

indicating the property has been selected for 

removal.  The icon to the left of the property 

name changes to the undo icon ( ). Note 

that not all properties have this icon, because 

not all properties can be deleted. 

¶ Click the OK or Apply button to delete the 

property. Click the undo icon ( ) to cancel 

the delete action and keep the property. 

  

To change the value for a property, change the 

entry in the Value column.  For yes/no properties, 

such as Active or Allow dragging, check or 

uncheck the boxes next to the property name.  

Other properties, such as colors and icons, are 

described below. 

 

Tip: If multiple elements are selected, changing 

the value of a particular property will change that 

value to all the elements in the group. 
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¶ When satisfied with any changes click the 

Apply button to apply the changes; or OK to 

apply the changes and close the Information 

box.  Click Cancel if you donôt want the 

changes applied.   

 

TIP: Once you click Apply or OK, the changes 

cannot be undone.  There is no undo option in 

Depiction. 

 

 

Color properties can be changed by clicking on 

the color bar to open the Select Color Attributes 

menu.  

¶ You can adjust the brightness by sliding the 

Brightness slider left (decrease brightness) 

and right (increase brightness). 

¶ You can adjust the transparency by sliding the 

Transparency slider left (decrease 

transparency) and right (increase 

transparency). 

¶ Click the OK button to save your color choice. 

If you do not want to save the change, click 

the Cancel button.   

¶ Click the No color button to set the color to be 

completely transparent. 

 
 

 

Icons can be customized using four different 

properties: 

1. Icon border shape 

2. Icon border color 

3. Icon path 

4. Icon Size 

 

Note: In previous versions of Depiction there was 

a separate screen for changing icon information.  

In version 1.3 and later, all icon properties are in 

the screen. 

 

To give an icon a border, the icon border shape 

property must be set to square, circle or triangle.  

 

To then change the icon border color click on 

the color bar and the color selector window will 
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appear as described above.  

 

To change the image used for an icon, click the 

Icon path button. This will open the Icon 

Selection Information menu.  

 

From here you can select an icon used by a 

default Depiction element under default 

application resources, an icon used by an add-

on or custom element under application 

resources, or any image on your computer under 

Load from a file. Click OK to apply your changes. 

 

To change the Icon size, use the dropdown menu 

to select a size from ñLilliputianò to ñExtra-largeò. 

 

Tip: When using Load from a file to assign a 

custom icon to an element, best results will come 

from square images between 25x25 pixels and 

100x100 pixels and 1 and 5 kilobytes. GIF and 

PNG files with transparent backgrounds will look 

the best.  

5.2.2 Add a Property  

ManageĄElementsĄView/Edit ĄAdd a Property  

 

To add a new property for a selected element or a 

group of elements 

¶ Enter a Property name at the bottom of 

the menu.  

¶ Select a property type from the dropdown 

list. Types include measurements, text, 

number or a Yes/No option that will appear 

as a check box next to the property. 

¶ Click the  button to add the new 

property to the selected elements.  

¶ If you do not want to add the new property, 

click the Cancel button. 

¶ Click Apply and the property will appear at 

the bottom of the properties list. 
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5.2.3 View, Add, or Delete Tags  

ManageĄElementsĄView/Edit ĄSet Tags 

 

Tags are a flexible way to manage your elements. 

Elements are given a source tag by default, but 

you can add, remove or change tags in any way 

you wish.  

Set tags:  To view, add, or delete tags Set tags 

and all tags associated with the selected elements 

will appear in the window.  

¶ To add a new tag, enter a term in the textbox 

at the bottom of the dialogue box and click 

. The new tag is added to the list. 

 

 

¶ Here the new tag ñHospitalsò is shown. 

¶ Be sure to click OK or Apply after adding or 

changing tags, or your changes will not be 

saved 

 

¶ To delete a tag, click the delete icon ( ) to 

the left of the tag to be deleted. The tag name 

appears with a strikethrough line and the icon 

on the left of the tag name changes to the 

undo icon ( ).  

¶ Click the OK button or the Apply button to 

delete the tag. Click the undo ( ) icon on the 

left of the tag to cancel the delete action and 

keep the tag. 

 

5.2.4 View, Add, or Delete Hover Text  

ManageĄElementsĄView/Edit ĄSet Hover Text   

 

Set hover text: To view, or change, the hover 

text or labels used by elements, click 

. A window appears listing all the 

properties of the selected element(s).  

¶ A Do not change element hover text radio 

button appears at the top of the window and 

is selected by default. 

¶ To change the hover text, select the Change 

element hover text to the following radio 

button. 

¶ Select the properties to be visible as hover 
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text by checking the checkbox next to the 

listed properties.  

¶ Select the checkbox next to the Permanent 

hover text option to see the text 

permanently on the display. Leave the 

option unchecked if you want to see the 

hover text only when the mouse is over the 

element. 

¶ Select Use label to show an html-enabled 

version of the hover text (as used, for 

example, for directions when you double-

click the Route - road network element). For 

best results, select a single property for the 

hover text and put all of the text you want to 

have in the label in that property field 

with HTML tags  .  

¶ The Display property name check box, 

when checked, will add the property name in 

front of each value in the hover text. 

¶ Deselect properties by clearing the 

checkbox next to the properties.  

¶ Click OK or Apply to activate the changes.  

 

¶ Note that, unlike the Set properties screen, 

when a group of elements has been 

selected, all properties for all elements will 

be visible in the Set hover text screen.  

http://www.w3schools.com/tags/default.asp
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5.2.5 View, Change, or Remove Colors  

ManageĄElementsĄView/Edit ĄColorize  

 

Colorize:  To thematically map a group of shape 

elements by color variation or put a colored 

square around the icon, click Colorize and a 

Colorize element(s) window appears with four 

radio buttons.  

¶ Do not change colors is the default.  

¶ Select the Remove colors radio button to 

remove any colored square or thematic 

mapping associated with the element or group 

of elements. 

 

¶ Select the Use a rangeé radio button to 

enable thematic mapping when a group of 

elements is selected.  

¶ The properties common to the selected 

elements are displayed. 

¶ First, select the property that you wish to base 

the colorization on. It is best if this property 

contains positive integers. For example, 

Population. 

 

 

¶ Check the Manual range selection box and 

you will be provided a window to enter the 

specific high and low values to be set as the 

start and end color.  If this box is not checked, 

Depiction will use the lowest and highest 

values found among the elements for the 

highlighted property to determine the range. 

¶ Clicking the Start color and End color 

buttons opens the Select Color Attributes, 

where the colors can be selected as described 

in 5.2.1. 

¶ The Start color will be associated with the 

lowest value, and the End color with the 

highest value. 

¶ Click Apply to activate the thematic mapping. 
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5.3 Delete Elements  

ManageĄElementsĄDelete 

 

To delete an element:  

¶ Select the element or group of elements 

that you want to delete in the Elements 

tab in the Manage Content dialog box. 

¶ The Confirm element deletion message 

appears.   

 

¶ Click Yes to delete the selected elements 

or No to cancel the deletion. 

  

There are three other ways to delete an 

element from a depiction outside of Manage 

content. 

¶ By right clicking on an element, 

selecting the element from the context 

menu and clicking Delete element. 

¶ By holding shift and clicking on an 

element. 

¶ By pressing the Delete button in the 

Properties box.  

5.4 Exporting Elements  from Depiction  

Depiction allows you to export point, line and shape elements to a GML (Geography Markup 

Language) or a CSV (Comma Separated Value) file. This is useful for sharing Depiction data 

with other applications, and for copying a subset of data in your depiction to another depiction. 

You can export elements using the Manage ContentĄElementsĄExport to File option, or 

from the Properties box. 

5.4.1 Exporting to  a GML File 

The GML file will not contain any behaviors used by the exported element(s) or any values for 

properties with units (such as "3 feet"). In addition, if you load this GML file into a depiction, and 

it cannot find the path to the icon you used, the element will display a question mark in lieu of 

the desired icon. 

Depiction creates two files for each export: a GML file (containing the data) and a XSD file 

(specifying the xml schema used by the GML file). Some applications may require the XSD file 

when reading the GML file so they should remain in the same folder. 
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The Export to GML option is a good way to speed the loading process of elements into future 

depictions. Save the elements to a .gml file and then use that file to load the elements into other 

depictions. This works especially well for shapefiles containing line and shape elements.  

ManageĄElementsĄExport to GML  

 

To export elements to a GML file: 

¶ Select the element or group of 

elements in the Elements tab in 

the Manage Content dialog box. 

¶ Click the Export to File option. 

¶ The message box to the left will be 

displayed. 

¶ If you wish to continue select ñYesò 

if not ñNoò. 

 

 

Enter the following details: 

Save in: Select the folder on your 

computer from the Save in dropdown list.  

¶ File name: Enter a file name in the 

File name textbox.  

¶ Save as type: The default file 

extension is .gml. 

¶ Click  to save the file. 

¶ Or  to abort the operation. 

 

5.4.2 Exporting to a CSV  File 

Depiction can export elements to comma-separated value files or CSV files. This is useful for 

making depiction data available to spreadsheet and database programs. 
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ManageĄElementsĄExport to CSV 

 

To export elements to a CSV file: 

¶ Select the element or group of 

elements in the Elements tab in the 

Manage Content dialog box. 

¶ Click the Export to File option. 

¶ The message box to the left will be 

displayed. 

¶ If you wish to continue select ñYesò if 

not ñNoò. 

 

Tip: In version 1.3 shapes can now be 

saved to a csv file. 

 

Enter the following details: 

¶ Save in: Select the folder on your 

computer from the Save in dropdown list.  

¶ File name: Enter a file name in the File 

name textbox.  

¶ Save as type: The default file extension 

is .gml and it is the default selection. 

¶ Click on the  at the end of the Save as 

type: line and choose CSV. 

¶ Click on Save. 

 

If shapes or lines were included in the 

exported elements, Depiction will ask if you 
want to include the element zones of 
influence in the export. This will allow those 
shapes and lines to be imported into other 
depictions, but may cause problems when 
loaded into spreadsheet software such as 
Microsoft Excel. 

¶ Click Yes to include the ZOIs 

¶ Click No to export only the data 

properties of an element. 

5.5 Sending Elements  as Email 

Depiction allows you to share element information with others by sending emails (one email per 

element) directly from the Depiction application.  Each element email is sent in a format that 

Depiction's Live Reports feature can interpret.  Sending the element email to an email account 
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that is being used for Live reports input by other Depiction users results in all those users 

receiving the same elements and information at nearly the same time.    

Occasionally, Depiction won't be able to understand the format of the field of an email. This 

happens, for instance, if the email name includes spaces and is not properly quoted. In this 

case, the From property for that element will be given the value unknown@address.com. 

For more details on sending and receiving elements, see Section 10.1. Basic instructions follow.  

ManageĄElementsĄEmail  

 

To send an element as email:  

¶ Select the specific element(s) you wish to send 

via email in the Elements tab in Manage 

Content. 

¶ Click the Send button. The Send as Email box 

appears.  

¶ Enter the following details: 

¶ To: One or more email addresses (use 

commas or semi-colons to separate 

addresses), such as 

live.report@mycompany.com 

¶ From: A legitimate email address, such as 

me@mycompany.com 

¶ Outgoing email server: The name of your 

email server, such as mail.mycompany.com 

(ask your system administrator). 

 

Tip: The Account name field (ñNew Accountò by 

default) is a drop down list of accounts you have 

used to send before: it will be empty if this is your 

first time sending. 

Tip: You can also use free email services such as 

Gmail or Hotmail. See section 10.1 for more details. 

 

¶ You need to provide the following details only if 

your email server requires authentication: 

¶ Use SSL: Select the checkbox to send the 

email through SSL (Secure Socket Layer). 

¶ Use authentication: Select this checkbox if 

your email server requires it (it usually 

doesðask your system administrator). 

¶ User name: Enter the user name for use 

during authentication. 

mailto:unknown@address.com
mailto:live.report@mycompany.com
mailto:me@mycompany.com
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¶ Password: Enter the password for use 

during authentication.  

¶ Click the Send as email button to send the 

email(s). 

 You can also send elements as email from the 

Properties box:  

¶ Click the Send button. The Send as email box 

appears. Follow the process described above. 

If you have changed properties in the element you 

are sending, click the Apply button before clicking 

Send. 
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Section 6 : Display Content  
 

The presentation aspect of a depiction ï the display ï is perhaps the most important feature of 

the software. Depiction allows multiple data elements of varying formats to be displayed in an 

integrated yet uncluttered way. Depiction can display elements across the entire depiction area 

or selectively using RevealerÊ technology. Revealers are rectangular or circular ñwindowsò of 

any size that reveal selected elements. Depiction allows an unlimited number of revealers and 

an unlimited number of elements in each revealer.  

Open Display Content by clicking on Display on the main menu bar. 

6.1 Display Content  

 

Main Menu ĄDisplay  

 

The Depiction display is controlled using Display 

Content. 

¶ Select Display on the main menu bar. Or 

right-click in your depiction and select the 

Display Contenté option from the popup 

menu. The Display Content menu appears.  

¶ Display Content has two tabs: 

¶ Show always: Enables you to select the 

elements that you want to display on the 

background of your depiction. 

¶ Show in revealer(s): Enables you to 

select the elements that you want to 

display in Revealers.  

¶ The List by dropdown menu lets you list 

elements by Type or by Tag, or you can 

select Show all to list all elements 

alphabetically by name. 

¶ The ñDisplay Contentò window is re-sizeable. 

 

Tip: Depiction automatically assigns a tag to 

each element based on the source from which 

you imported  the element.  
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6.2 Show Elements on  Background  

Display Content ĄShow always  

 
 

 
 

¶ With the Show always tab selected (the 

default selection), the elements selected 

window lists all the elements in your 

depiction.  Groups of elements can be 

expanded by clicking on the arrow to the left 

of the individual elements in that group.  

Clicking the arrow again collapses the list. 

¶ Display an element or group of elements by 

clicking on the checkbox ( ) next to the 

element(s). An x mark appears in the 

checkbox. If a / appears in the box, it means 

that some of the elements in the group are 

selected, but not all. The total number of 

displayed elements is shown in the heading 

above the window.  

¶ To remove an element from the Show 

always list, click the checkbox next to the 

element(s) to uncheck the box. The x mark in 

the checkbox disappears and the element is 

no longer displayed.  

¶ You can find a subset of elements by using 

the Filter elements by hovertext box. Enter 

text here, and only elements having matching 

text in their hovertext will be listed.  
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6.3 Show Elements in Revealers  

Display Content ĄShow in Revealer (s) 

 

¶ With the Show in revealers tab selected, the 

Your revealers pane lists the existing 

revealers. 

¶ Click on the revealer name in the Your 

revealers window to select a revealer. The 

elements selected window will appear and list 

the elements displayed assigned to the 

selected revealer.  For example, in the figure on 

the left, the Street Map (OpenStreetMap) 

element is displayed in the Street Map 

(OpenStreetMap) revealer. 

¶ You can add more elements to the revealer by 

selecting more elements in the elements 

selected list. To show or hide an element, click 

on the checkbox next to the element. An x mark 

in the checkbox indicates that the element is 

shown. A / appears in a checkbox for a group of 

elements if not all the elements in the group are 

shown. 

 
 

 

 
 

 

 
 

 

 

In the Your revealers box: 

¶ Select the revealer by clicking on the revealer 

name in the list.  

¶ Change the name of the revealer by typing 

in a new name in the textbox. 

¶ Show or hide the revealer by clicking on the 

revealerôs eye icon. The eye icon with a line 

across it ( ) indicates that the revealer is 

hidden. The eye icon without a line across it 

( ) indicates that the revealer is displayed. 

¶ You can delete a revealer by clicking on the 

revealerôs X icon. The Delete revealer 

message appears. Click Yes to delete the 

revealer or No to cancel. Deleting a 

revealer removes only the revealer, and 

does not affect the elements displayed in it. 

Tip: Hiding the elements also does not delete 

them. The elements are still there and still interact 

with other elementsðthey are simply not displayed 

in the depiction. 






































































































































